Common Mistakes Guide

**IMPORTANT:**

Theses installments that contain errors will be sent back for revision and may delay approval of your document. Please note that you may avoid this delay by carefully checking each installment for frequent mistakes using the Common Mistakes Guide before you submit. Failure to revise your document for Common Mistakes before submitting may result in a delay in grading. All returned documents must be revised within two business days for approval.

---

**Issue #1: Your document has incorrect page numbers.**

First, determine what caused the numbering error in your template:

A. Your document is missing all page numbers.
B. Your Table of Contents (ToC) exceeds one page and your Abstract Page is not Page 1 (Arabic numeral).
C. Your Table of Contents (ToC) is one page but your Abstract Page is still not Page 1 (Arabic numeral).

If A: Make sure you are using our pre-prepared thesis template. If not, download one from our website (http://ugr.tamu.edu).

If B: Example:

![Example Table of Contents](image)

(B Solution on next page)
B Solution:
1. Insert cursor at the end of the last line on the first page of the ToC.
2. Next, navigate to the Layout tab and select the Breaks drop-down menu.
3. Then, under Section Breaks, click Continuous to resolve the numbering error.
4. Repeat Steps 1-3 if you add more content to your ToC.

Example:

(C Solution on next page)
C Solution:

1. The goal of this solution is to make sure that a brand new Footer Section starts on your Abstract Page and that the new Footer Section is not linked to the previous Footer Section.

2. To do this, double-click the footer on your Abstract Page, so that the Footer Sections show up. Note the footer section in which your Abstract Page appears.

3. Put your cursor at the very end of the content on your Table of Contents page.

4. Navigate to the Home tab and select the paragraph button next to Styles. Check the location of your cursor to make sure there is not a Page Break after it.
   a. If there is a Page Break, you will need to delete it before moving on. To do this, hold down Shift, highlight the Page Break, and hit delete.

5. Next, navigate to the Layout tab and select the Breaks drop-down menu. (See example above from 1B Solution.)

6. Select “Next Page.” After the new Footer Section is created, you may need to fix the spacing at the top of your Abstract Page.

7. Double-click the footer on your Abstract Page and deselect “Link to Previous” on the tool bar.

8. Delete any page numbers on the pages before your Abstract Page.

9. Double-click the footer on your Abstract Page again, and navigate to the Page Number drop-down menu. Select “Format Page Numbers.”

Example:

10. In the dialogue box, select “Start at” and put 1 in the box. Hit OK.
Issue #2: The leader dots in the Table of Contents are broken.

First, determine which issue is causing problems with the leader dots:

A. Accidentally deleted pre-prepared leader dots.

B. Leader dots that look different than the others.

C. Mismatched leader dots with periods.

D. Too much space in between text and leader dots.

A-D Solutions:
1. Our thesis templates are set to create leader dots using the “Tab” key on your keyboard.
2. Place your cursor directly after the text and hit the “Tab” key to auto-create leader dots.
3. DO NOT use periods or other characters to fill in leader dots.
4. Older versions of Microsoft Word and Microsoft Word for Mac may not cooperate with these settings.
   If this is the case, try copying and pasting existing leader dots into the area where leader dots are missing.

Example:

CHAPTER (OR OTHER MAJOR SECTION DESIGNATION)
I. INTRODUCTION X
   Subheading 1 (remove/add as needed)............................................................................... x
   Subheading 2 (remove/add as needed)............................................................................... x
II. METHODS (CAN CUSTOMIZE NAME).................................................................................. x
**Issue #3: Inconsistent content or spacing in the Table of Contents (ToC).**

First, determine which issue is causing problems with the content or spacing:

**A. Your Chapter headings and subheadings must be worded exactly the same way in the ToC as they are in the body of the document.**

**A Solution:** Cross check each subheading in the body of the document with what is listed in the ToC. Always be consistent and proofread your work before submitting.

**B. Inclusion of the wrong type of subheadings in the ToC.**

**B Solution:** The ONLY subheadings that should be included in the ToC are first-order subheadings (the bold ones). Remove all second or third-order subheadings from the ToC.

**C. Inconsistent spacing after major headings or subheadings in the ToC.**

**C Solution:** Major headings and subheadings are followed by one single-spaced paragraph return. See example below to check for correct spacing.

**Example:**

```
TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
</tr>
<tr>
<td>ABSTRACT</td>
</tr>
<tr>
<td>DEDICATION (OPTIONAL)</td>
</tr>
<tr>
<td>ACKNOWLEDGEMENTS (OPTIONAL)</td>
</tr>
<tr>
<td>NOMENCLATURE (OPTIONAL, CAN BE RENAMED)</td>
</tr>
<tr>
<td>CHAPTER (OR OTHER MAJOR SECTION DESIGNATION)</td>
</tr>
<tr>
<td>I. → INTRODUCTION</td>
</tr>
<tr>
<td>Subheading 1 (remove/add as needed)...</td>
</tr>
<tr>
<td>Subheading 2 (remove/add as needed)...</td>
</tr>
<tr>
<td>II. → METHODS (CAN CUSTOMIZE NAME)</td>
</tr>
<tr>
<td>Subheading 1 (remove/add as needed)...</td>
</tr>
<tr>
<td>Subheading 2 (remove/add as needed)...</td>
</tr>
<tr>
<td>III. → RESULTS (CAN CUSTOMIZE NAME)</td>
</tr>
<tr>
<td>Subheading 1 (remove/add as needed)...</td>
</tr>
<tr>
<td>Subheading 2 (remove/add as needed)...</td>
</tr>
<tr>
<td>IV. → CONCLUSION (CAN CUSTOMIZE NAME)</td>
</tr>
<tr>
<td>Subheading 1 (remove/add as needed)...</td>
</tr>
<tr>
<td>Subheading 2 (remove/add as needed)...</td>
</tr>
<tr>
<td>REFERENCES (CAN BE RENAMED)</td>
</tr>
<tr>
<td>APPENDIX (OPTIONAL)</td>
</tr>
</tbody>
</table>
```
Issue #4: A major heading is not at the top of a new page.

Issue #4 Solution:

1. Insert cursor at the end of the last line of the section before the new major heading.
2. Next, navigate to the **Layout** tab and select the **Breaks** drop-down menu.
3. Then, under **Page Breaks**, click **Page** to push your new section to the next page.

Example:

4. Check to make sure that your chapter heading is at the very top of the next page. If there is extra space between your chapter heading and the top 1” margin of the page, you will need to delete all of the extra space so that the chapter heading touches the top margin.
Issue #5: Your document has inconsistent paragraph spacing.

First, determine which issue is causing the inconsistent spacing in your document:

A. You are inconsistently adding a line of space in between some paragraphs and not others. Decide which type of spacing you will use throughout the entire document and correct all instances of inconsistent spacing.
   Note: Do not add empty lines below subheadings.

B. Microsoft Word adds extra space before and after paragraphs automatically.
   Example:

   ![Example Image]

   Note significantly more space in between all lines.

   (B Solution on next page)
B Solution:

1. Hold Ctrl + A on your keyboard to select all text in the document.
2. Find the Line and Spacing Options in the Paragraph area in the top ribbon of Microsoft Word.
3. Under Spacing, set both the Before and After Spacing to 0. Then, click OK.

   Example:

4. You will need to go back through and DOUBLE-CHECK your document. This can affect the spacing around figures and tables.
Issue #6: Your document has inconsistent indentations.

First, determine which issue is causing the inconsistent indentations in your document:

A. You are inconsistently using indentations in some paragraphs and not others. Decide whether or not you want to indent paragraphs in the entire document and correct all instances of inconsistent indentations.

B. Your indentation settings are not equal in size throughout the document.

Example:

First order subheadings

Directed above is a first order subheading. If you feel that the information under a first order subheading needs to be split into more sections, use additional subheadings. Take note that all first order subheadings must be included in the Table of Contents. Second and third order subheadings are NOT be included in the Table of Contents.

Second order subheadings

This information still pertains to your first order subheading. If you need to break up content even further, you can use one last level of subheadings, called third order subheadings.

Note difference in size of indentations.

B Solution:

1. Place your cursor directly in front of the incorrect indentation.
2. Find the Line and Spacing Options in the Paragraph area in the top ribbon of Microsoft Word.
3. Under Indentation, set By to 0.5. Then, click OK.
Issue #7: Your subheadings are formatted incorrectly.

Issue #7 Solution:

1. Check ALL of your subheadings.
2. First-order subheadings need to be bold. Second-order subheadings need to be *italicized*. Third-order subheadings should not have any special formatting.
3. Do not underline subheadings.

**Example of proper subheading format:**

**First order subheadings**

Directly above is a first order subheading. If you feel that the information under a first order subheading needs to be split into more sections, use additional subheadings. Take note that all first order subheadings must be included in the Table of Contents. Second and third order subheadings are NOT be included in the Table of Contents.

**Second order subheadings**

This information still pertains to your first order subheading. If you need to break up content even further, you can use one last level of subheadings, called third order subheadings.

**Third order subheading**

This information still pertains to your first order subheading, but is directly related to your second order subheading.

NOTE: If you have any **bold** subheadings in your document, they need to be listed in your Table of Contents in the correct section.
Issue #8: Your figures/tables are formatted incorrectly.

Issue #8 Solution:

Check ALL of your figures and tables for the following:

- Make sure the wrap setting is on “In-Line with Text” and that your figure/table is centered.
  
  **Example:**

- Do NOT embed your figures/tables.
- Every figure needs a label directly below it.
- Every table needs a label directly above it.
Issue #9: The names, major(s), or departments listed on the Title or Abstract Pages are formatted incorrectly.

Issue #9 Solution:

The names of all team members should be listed alphabetically by last name. For teams with three or more members, the list of names should be separated by commas and the word “and.”

An Undergraduate Research Scholars Thesis

by

ANNABELLE G. AYMOND, SARAH M. MISEMER, and MARY C. SONNIER

With the exception of a two-person team with both members having the same major/department, all team members should have an individual name statement on the Abstract page.

ABSTRACT

This is the Title of My Thesis and It Matches the Title on My Title Page.

Annabelle G. Aymond  
Department of Communication  
Texas A&M University

Sarah M. Misermer  
Department of Hispanic Studies  
Texas A&M University

Mary C. Sonnier  
Department of English  
Texas A&M University

Issue #10: Your References Page is formatted incorrectly.

Single-spacing your entire references page is **incorrect**:

```
REFERENCES

Reference, Example. This is an Example Reference that Conforms to MLA. College
Reference2, Example. This is Meant to Demonstrate Spacing Between Entries. College
```

Double-spacing your entire references page is also **incorrect**:

```
REFERENCES

Reference, Example. This is an Example Reference that Conforms to MLA. College
Reference2, Example. This is Meant to Demonstrate Spacing Between Entries. College
```

**Issue #10 Solution:**

Regardless of the citation style you have chosen to use, the Thesis Manual & Policy Guide requires the following formatting for the References Page:

- Individual reference entries must be single-spaced.
- The spaces between each individual reference entry must be double-spaced.

Individual reference entries must be single-spaced with a double-spaced line between entries. See **correct** example below:

```
REFERENCES

Reference, Example. This is an Example Reference that Conforms to MLA. College
Reference2, Example. This is Meant to Demonstrate Spacing Between Entries. College
```